
Специальные методы 
постобработки 
и визуализации  
в COMSOL Multiphysics®

рукОвОДСТвА COMSOL



СÊÀÑÃ»Æ×ÈÖÀ ÇÀÍÉ¿Ö ÊÉÌÍÉ¼Ë»¼ÉÍÅÃ 
Ã ½ÃÂÎ»ÆÃÂ»ÑÃÃ ½ COMSOL MXOWLSK\VLFV 
COMSOL, COMSOL Multiphysics, Capture the Concept, 
COMSOL Desktop, LiveLink и COMSOL Server являются 
зарегистрированными товарными знаками или товарными 
знаками компании COMSOL AB. Любые другие торговые 
марки являются собственностью их владельцев. Корпорация 
COMSOL AB, ее дочерние компании и продукция, не связаны 
с этими владельцами, не утверждались, не финансировались 
и не поддерживались ими.  
© 2015 г. COMSOL.

кÉÈÍ»ÅÍÈ»Ú ÃÈÏÉËÇ»ÑÃÚ 
Подать запросы общего характера, обратиться в службу 
технической поддержки, а также найти нужный адрес и номер 
телефона можно на странице контактов COMSOL: www.comsol.
ru/contact. Дополнительные адреса и контактная информация 
доступны на странице глобальных центров продаж:  
www.comsol.ru/contact/o�ces.

Онлайн-форма запроса в техническую поддержку находится 
на странице COMSOL Access: www.comsol.ru/support/case.

ДÉÊÉÆÈÃÍÀÆ×ÈÖÀ ËÀÌÎËÌÖ 
Дополнительные ресурсы и учебные материалы, посвященные 
инструментам постпроцессинга в COMSOL®:

ПрЕДЫДу´ЕЕ рукОвОДСТвО� ОСНОвЫ ПОСТОбрАбОТкИ 
И вИзуАЛИзАЦИИ в COMSOL MuLtiphySiCS 
https://www.comsol.ru/o ers/
Postprocessing-and-Visualization-Handbook-Part-1-ru

вИДЕО 
http://www.comsol.ru/videos?work­ow=work­owstep-results

бЛО� 
https://www.comsol.ru/blogs/category/all/postprocessing/

¯ОруМ 
https:// www.comsol.ru/community/forums/results-and-visualization/

бАзА зНАНИ¤ 
https://www.comsol.ru/support/knowledgebase/browse/900/

LL



СОДЕРЖАНИЕ
Введение											           1

ПОСТРОЕНИЕ ГРАФИКОВ ВЫРАЖЕНИЙ  
и интерпретация результатов
▪ Создание пользовательских выражений							       2
▪ Использование производных значений для проверки модели				    4
▪ Графики для отображения сетки								        5
▪ Деформации, выражения для высот и масштабирование)					    6
▪ Операции для интерпретации результатов							       7

Инструменты визуализации
▪ Управление видом и камерой									         13
▪ Освещение и сцена										          20

Типы графиков для отдельных  
физических задач
▪ Графики в дальней зоне										         23
▪ Трассировка частиц										          24

СОВЕТЫ И РЕКОМЕНДАЦИИ  
ДЛЯ ОПЫТНЫХ ПОЛЬЗОВАТЕЛЕЙ
▪ Идеи для эффектных визуализаций								        26
▪ Анимация												            30
▪ Отрисовка и сглаживание									         31

Постобработка низкоразмерных объектов
▪ Повторение терминологии									         33
▪ Свойства тонкого слоя										          34
▪ Нарушения непрерывности									         36
▪ Операторы Up (Верх) и Down (Низ)								        36
▪ Оператор Side (Сторона)										         37
▪ Сравнение графиков областей и границ							       38
▪ Резюме												            40

ЗАКЛЮЧЕНИЕ											          41

iii



iv



�СПЕЦИАЛЬНЫЕ МЕТОДЫ ПОСТОбрАбОТкИ И вИзуАЛИзАЦИИ в COMSOL MuLtiphySiCS

ввЕДЕНИЕввЕДЕНИЕ

МОДЕЛИрОвАНИЕ СТАТИ²ЕСкО�О ПОЛº

Модель ротора Хальбаха, состоящего из 4-полюс-
ных пар. На графике показана плотность магнит-
ного потока в поперечном сечении в зависимости 
от угла поворота ротора.

Добро пожаловать! Если вы читаете это, значит, 
первая часть этого набора руководств, Осно-
вы постобработки и визуализации в COMSOL 
Multiphysics®, помогла вам изучить методы посто-
бработки и визуализации, которые используются 
в среде COMSOL Multiphysics®.

В первой части мы учились использовать наборы 
данных, производные значения и группы графи-
ков. В конце мы проработали несколько полезных 
советов, например отображение сетки на поверх-
ностях, интерактивные инструменты размеще-
ния и сочетания клавиш, с помощью которых 
можно управлять узлом View (Вид) и выделением 
объектов.

В этой части мы сделаем шаг вперед и присталь-
нее изучим гибкие возможности постобработки 
в среде COMSOL®, которые нужны для более 
опытных пользователей. В частности, это методы, 
помогающие проверить, понять и согласовать 
вашу модель. Они включают в себя операции 
над наборами данных, создание деформаций для 
отображения реалистичных смещений, задание 
пользовательских выражений и интерпретацию 
результатов.

Наконец, мы вкратце затронем специфичные для 
отдельных задач вопросы, например: когда следу-
ет и когда не следует менять разрешение и сгла-
живание графиков, как улучшить визуализацию 
с помощью инструментов камеры и освещения, 
какие комбинации помогут создать впечатляю-
щие визуализации и какие методы постобработки 
применяются для объектов более низкой размер-
ности, чем сама модель.

Мы надеемся, что предлагаемое руководство 
поможет вам посмотреть на свои модели свежим 
взглядом и упростит процесс анализа, визуализа-
ции и распространения ваших работ.

ВВЕДЕНИЕ

https://www.comsol.ru/offers/Postprocessing-and-Visualization-Handbook-Part-1-ru
https://www.comsol.ru/offers/Postprocessing-and-Visualization-Handbook-Part-1-ru
https://www.comsol.ru/offers/Postprocessing-and-Visualization-Handbook-Part-1-ru
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СОздАние 
ПОльзОВАТельСКих 
ВЫРАЖениЙ
При построении графиков любого типа в среде 
COMSOL отображаемая величина определяется 
выражением. Прежде чем перейти к инструмен-
там визуализации, кратко остановимся на устрой-
стве этих выражений.

COMSOL предлагает множество заранее задан-
ных величин для построения графиков, но иногда 
бывает нужно создать свои собственные вы-
ражения. В качестве примера пользовательского 
выражения воссоздадим формулу для джоулева 
нагрева в модели электрической шины, к которой 
приложено напряжение в 20 мВ.

Откройте Библиотеку приложений (File > Application 
Libraries, Файл > Библиотеки Приложений) и вы-
берите COMSOL Multiphysics > Multiphysics > busbar 
(COMSOL Multiphysics > Мультифизическое модели-
рование > Электрическая шина). Это моделирование 
показывает нагрев электрической шины, вызванный 
протекающим через нее электрическим током.

Математическое описание джоулева нагрева — 
это рассеиваемая мощность 
Математическое описание джоулева нагрева — 

, где  — это 
плотность тока, а 
это рассеиваемая мощность 

 — электрическое поле.

Эквивалент этой физической величины 
в COMSOL — плотность рассеиваемой мощности, 
которая обозначается ec.Qrh (префикс ec относится 
к интерфейсу Electric Currents (Электрические токи) 
в этой модели, а сама величина называется Resistive 
losses, ( Реостатные потери). Эти величины можно 
найти, щелкнув Replace Expression (Заменить выра-
жение)  в настройках графика, и проведя поиск 
в поле Type �lter text (Введите текст фильтра):

Добавьте группу 3d-графиков в узел Results (Ре-
зультаты) модели электрической шины и добавьте 

график скалярного поля к этой группе. В этом узле 
мы изучим несколько различных величин. Для на-
чала постройте выражение ec.Qrh.

На первый взгляд, в электрической шине мало 
реостатных потерь, и они в основном сосредото-
чены в одном болте в задней части.

Если щелкнуть электрическую шину в любом 
месте, вы вызовете таблицу Evaluation 3D (Трех-
мерная оценка) ниже графического окна. В табли-
це будут показаны координаты точки, которую 
вы щелкнули, и величина реостатных потерь 
в этой точке. Они будут варьироваться от очень 
малых — порядка единиц — до тысяч ватт на ку-
бический метр (Вт/м3); но так как основная часть 
шины нагревается значительно меньше, чем болт, 
градиент цвета кажется практически однородным 
на большом диапазоне значений.

Скалярное произведение, соответствующее джоу-
леву нагреву, представляется суммой леву нагреву, представляется суммой

. Эквивалентное этому 
выражение в обозначениях COMSOL ec.Jx*ec.Ex + 
ec.Jy*ec.Ey + ec.Jz*ec.Ez. Если вы построите это 
выражение, график будет выглядеть точно так же, 
как график выражения ec.Qrh.

ПОСТРОЕНИЕ ГРАФИКОВ ВЫРАЖЕНИЙ 
И ИНТЕРПРЕТАцИя РЕзульТАТОВ

ССЫЛкА

Различные типы графиков, 
доступные в программном 
пакете COMSOL 
Multiphysics®, описаны 
в разделе Plot Types (Типы 
графиков) руководства 
«Основы постобработки 
и визуализации в COMSOL 
Multiphysics®».

СОвЕТ

Сочетание клавиш 
Ctrl + Пробел вызывает 
функцию автодополнения, 
открывая меню Replace 
Expression (Заменить 
выражение) со списком 
величин, в названиях 
которых содержатся 
введенные в поле Expression 
(Выражение) символы.

https://www.comsol.ru/offers/Postprocessing-and-Visualization-Handbook-Part-1-ru
https://www.comsol.ru/offers/Postprocessing-and-Visualization-Handbook-Part-1-ru
https://www.comsol.ru/offers/Postprocessing-and-Visualization-Handbook-Part-1-ru
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Мы можем легко разбить это выражение на слагае-
мые и посмотреть, какой вклад вносит каждое сла-
гаемое. Замените выражение на произведение тока 
и электрического поля в направлении x(ec.Jx*ec.Ex); 
график выглядит почти так же, как раньше.

Однако если мы заменим выражение на ec.Jy*ec.Ey, 
мы увидим, что рассеиваемая мощность, связан-
ная с направлением yменьше (в верхней части 
на иллюстрации ниже); большая часть рассеива-
ется у заднего болта, но меньше, чем рассеиваемая 
мощность, связанная с направлением x. Еще мень-
ше рассеиваемая мощность, связанная с направле-
нием z (в нижней части на иллюстрации ниже):

Теперь постройте норму плотности тока, ec.normJ. 
Вы снова увидите, что ток сосредоточен вокруг 
заднего болта.

Отключите узел этого графика скалярного поля 
и добавьте второй график скалярного поля к груп-
пе графиков. Постройте норму электрического 
поля, ec.normE. И в этом случае электрическое 
поле вновь сосредоточится внутри болтов. Джо-
улев нагрев описывается скалярным произведе-
нием этих двух величин, и следовательно, график 
покажет максимум нагрева в области болта.

Отключите график нормы электрического 
поля и добавьте векторный объемный график. 
По умолчанию строится график плотности тока. 
Вы можете использовать приведенные ниже 
настройки графика или настроить их в соответ-
ствии с собственными предпочтениями.

ПРИМЕЧАНИя
Имена выражений следуют шаблону interface.quantity (интерфейс.величина). Например, ec.Jx*ec.Ex обозначает произведение 
x-компонент векторов плотности тока и электрического поля, которые определены в интерфейсе физики Electric Currents 
(Электрические токи). В программный пакет COMSOL® встроены многие другие математические операторы и функции, 
список которых приводится в разделе Global and Local De�nitions (Глобальные и локальные определения) в руководстве COMSOL 
Multiphysics Reference Manual из документации COMSOL. Вы также можете создавать свои переменные и операторы и вводить 
их вручную, следя за тем, чтобы величина, которую вы строите, была корректно определена.
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В результате векторный график показывает силу 
тока в разных точках электрической шины. Вектор-
ный график на иллюстрации ниже показывает цве-
том величину нормы электрического поля, ec.normE.

График подтверждает, что болты оказались об-
ластями с максимальной плотностью тока, и эти 
области будут нагреваться сильнее всего. Стрелки 
также показывают, как показывали и графики 
джоулева нагрева, что большая часть реостатных 
потерь связана с направлением x.

иСПОльзОВАние 
ПРОизВОднЫх знАчениЙ 
для ПРОВеРКи мОдели
В руководстве Основы постобработки и визуализа-
ции в COMSOL Multiphysics мы кратко коснулись 
производных значений. Производные значения мо-
гут не только помочь вам проанализировать показа-
тели эффективности, специфичные для вашего при-
ложения, но и рассказать многое о сетке, с которой 
вы работаете. Во время проверки точности модели, 
помимо прочего, следует убедиться, что сетка до-
статочно мелкая, чтобы описать поведение системы. 
Для этого хорошо подходят Global Evaluations (Гло-
бальные вычисления), одни из нескольких произво-
дных значений, доступных в среде COMSOL.

Откроем модель радиатора, которая использова-
лась в первом руководстве. Если у вас установлен 
модуль Heat Transfer (Теплопередача) или CFD 
(Вычислительная гидродинамика), откройте модель 
радиатора, выбрав меню File > Application Libraries 
> Heat Transfer Module > Tutorials, Forced and Natural 
Convection (Файл > Библиотеки приложений > Мо-
дуль Теплопередача > Учебные модели, вынужден-
ная и свободная конвекция) или File > Application 
Libraries > CFD Module > Non-Isothermal Flow (Файл 
> Библиотеки приложений > Модуль Вычислитель-
ная гидродинамика > Неизотермический поток).

Если свойства материалов и граничные условия 
заданы правильно, важным показателем точности 
модели является сохранение массы и энергии. В узле 
Results (Результаты), раскройте узел Derived Values 
(Производные значения). После того как вы изучите 
существующие подузлы, удалите или отключите их, 

чтобы мы могли продемонстрировать весь процесс 
с чистого листа. Затем добавьте два глобальных вы-
числения через контекстное меню.

Первое глобальное вычисление даст нам поток мощ-
ности, протекающий через устройство. В настройках 
перейдите к Replace Expression > Model > Component 
1 > Heat Transfer > Global > Net powers (Заменить вы-
ражение > Модель > Компонент 1 > Теплопередача > 
Глобальные величины > Отбираемая мощность) и вы-
берите ht.nte�uxInt — полная отбираемая мощность.

ОбНОвЛЕНИЕ 
бИбЛИОТЕк

Приведенная в этом 
руководстве информация 
подразумевает, что 
вы пользуетесь 
обновленными 
Библиотеками приложений 
COMSOL. Чтобы обновить 
их, выберите пункт 
меню File > Help > Update 
COMSOL Application 
Library (Файл > Справка 
> Обновить Библиотеку 
приложений COMSOL). 
Затем щелкните Find 
Applications (Найти 
приложения) и Uncheck all 
(Снять все) на следующем 
экране. Перейдите 
к модели, которую 
вы ищете, выберите 
ее и щелкните Download 
(Загрузить).
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Щелкните Evaluate (Вычислить). Под графическим 
окном откроется таблица, показывающая значение 
полной отбираемой мощности: 0,99996 Вт. Так как 
тепловой поток был задан равным 1 Вт, мы видим, 
что энергия сохраняется с приемлемым уровнем 
точности.

Второе глобальное вычисление даст нам поток 
массы. В настройках Global Evaluation 2 (Глобаль-
ное вычисление 2) перейдите к Replace Expression > 
Model 1 > Component 1 > Laminar �ow (Заменить вы-
ражение > Модель 1 > Компонент 1 > Ламинарный 
поток) и выберитеspf.out1.M�ow — поток массы.

Щелкните Evaluate (Вычислить). Результат 2,709e-5 кг/с. 
Перемножив входную скорость потока (5 см/с), плот-
ность жидкости (1,2754 кг/м3) и площадь входного 
канала (3 см на 1,5 см), мы получим значение 2,8e-5 кг/с; 
это свидетельствует о том, что закон сохранения массы 
хорошо выполняется.

Так как эти вычисления совпали с ожидаемыми 
результатами, мы знаем, что сетка достаточно 
мелкая, и модель точна при изучаемых условиях 
эксплуатации.

ГРАФиКи для ОТОбРАЖения 
СеТКи
Качество постобработки, как и точность решения, 
сильно зависят от размера и качества элементов 
сетки. Слишком крупная сетка даст слишком мало 
точек на графике, а искаженные элементы повлияют 

на геометрическое и численное представление 
вашей модели. В обоих случаях точность будет низ-
кой. Мы уже обсуждали, как проверить, достаточно 
ли мелка сетка, с помощью производных значений. 
Теперь посмотрим на качество сетки.

Для того, чтобы определить качество сетки 
и визуализировать элементы геометрии модели, 
вы можете создать график для отображения сетки. 
Для его построения не требуется решать модель.

В модели радиатора в узле Component 1 (Ком-
понент 1) щелкните правой кнопкой мыши 
узел Mesh (Сетка) и выберите Plot (Построить). 
Вы увидите примерно следующее:

Прилагаемая цветовая шкала от 0 до 1 
по умолчанию показывает качество элементов. 
Вы можете также задать цвет, показывающий 
размер элемента, задать однородный цвет или 
отключить его. 

Качество сетки показывает, насколько ячейки сетки 
изотропны. Элемент с равными длинами ребер, 
например двумерный равносторонний треуголь-
ник, характеризуется качеством, равным единице. 
Полностью сплющенный треугольник с нулевой 
площадью будет характеризоваться нулевым 
качеством. Такие же геометрические формулы есть 
и для трехмерных тетраэдрических элементов. Для 
других типов элементов: параллелепипедов или 
призм — качество несет другой смысл.

СПрАвкА

Краткие сведения 
о глобальных вычислениях 
приведены в разделе Data 
Sets, Derived Values, and 
Tables (Наборы данных, 
производные значения 
и таблицы) руководства 
Основы постобработки 
и визуализации в COMSOL 
Multiphysics®. Дополнительная 
информация о производных 
значениях и интерпретации 
результатов содержится 
в подразделе Операции для 
интерпретации результатов 
в конце этого раздела

СОвЕТ

Иногда сетку в некоторых 
областях нужно сделать 
мельче, особенно если в этих 
областях присутствует 
большой градиент 
исследуемой величины. 
Подстройку сетки можно 
произвести с помощью 
инструмента Adaptive Mesh 
Re�nement (Адаптивное 
измельчение сетки), который 
анализирует ошибки 
решения и оптимизирует 
сетку соответствующим 
образом. Подробнее 
об отображении сетки 
на графике рассказывается 
в подразделе Комбинирование 
графиков раздела Советы 
и рекомендации для опытных 
пользователей .

https://www.comsol.ru/offers/Postprocessing-and-Visualization-Handbook-Part-1-ru
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деФОРмАции, 
ВЫРАЖения для ВЫСОТ 
и мАСШТАбиРОВАние
Ряд методов позволяет вам создать графики, на ко-
торых изменения модели: смещение, изгиб или 
сжатие — зрительно преувеличены. Это позволяет 
визуализировать деформации, которые в масштабе 
1:1 были бы незаметны.

Для демонстрации этих методов мы используем 
две модели: пьезоакустический преобразователь 
и микрозеркало. Возможно, вам не придется 
работать с такими моделями, но эти же методы 
могут быть применены к любой мультифизиче-
ской модели (например, смещения нелинейных 
или пьезоэлектрических материалов в механике 
конструкций могут быть построены так же, как 
и для упругих материалов).

Если у вас установлен модуль MEMS (Микроэлек-
тромеханические системы), перейдите к меню File 
> Application Libraries > MEMS Module > Actuators 
(Файл > Библиотеки приложений > Модуль MEMS 
> Приводы) и откройте модель микрозеркала. Эта 
модель представляет собой управляемое электро-
статическим способом микрозеркало. Такие опти-
ческие полупроводники часто играют роль отра-
жателей, например в цифровой кинематографии.

Механический анализ в трех измерениях по-
зволяет установить напряжения и деформации, 
необходимые для того, чтобы поднять зеркало 
на заданную высоту. Анализ проводится для 
двух устройств: со стальными и алюминиевыми 
пластинами, — и результаты показывают реакцию 
зеркала на разные величины предварительного 
напряжения.

Если вы следуете нашему руководству, добавьте 
группу 3D-графиков с графиком скалярного поля 
к узлу Results (Результаты). В поле для выражения 
автоматически подставляется выражение для 
смещения, так что сразу можно щелкнуть Plot 
(Построить).

График показывает деформацию в разных точках 
микрозеркала. Давайте сделаем ее чуть более реа-
листичной, чтобы лучше изобразить сдвиг.

Добавьте к графику скалярного поля деформа-
цию (щелкните правой кнопкой мыши Surface 1 
(Поверхность 1) и выберите Deformation (Дефор-
мация)). Программа автоматически подставляет 
(u, v, w) и строит компоненты поля смещения. 
Установите масштабный коэффициент, равный 1, 
и щелкните Plot (Построить).

Теперь поверх граней, показывающих исходное 
положение микрозеркала, мы видим деформацию.

Взглянем теперь на пьезоакустический преобразо-
ватель. Эта модель доступна в разделе меню File > 
Application Libraries > Acoustics Module > Piezoelectric 
Devices (Файл > Библиотеки приложений > Модуль 
Акустика > Пьезоэлектрические устройства), 
если у вас установлен модуль Акустика.

Пьезоакустические преобразователи преобразо-
вывают электрический ток в давление звука и на-
оборот. Их используют в самых разнообразных 
устройствах и приложениях, например в ультра-
звуковом оборудовании, сонарах, микрофонах 
и при построении изображений биологических 
объектов.

Преобразователь представляет собой прямоу-
гольник из пьезоэлектрического материала, за-
крепленный с одной стороны. Воздушная область 
представлена одной четвертью круга. Мы визуа-
лизируем давление звука в воздухе при приложе-
нии к преобразователю напряжения в 100 В.

Создайте новую группу 2D-графиков и добавьте 
к ней график скалярного поля. Перейдите к Replace 
Expression > Model > Component 1 > Pressure 
Acoustics, Frequency Domain > Pressure and sound 
pressure level (Заменить выражение > Модель > 
Компонент 1 > Скалярная акустика, частотная 
область > Давление и уровень давления звука) 
и выберите acpr.p_t — поле полного давления звука 
как выражение для графика. 

СОвЕТ

Вы также можете 
поэкпериментировать 
с x-, y-и z-компонентами, 
чтобы увидеть, как 
микрозеркало деформируется 
в разных направлениях. 
На иллюстрации ниже 
показаны деформации изгиба 
(только в направлениях 
xи y), где компонента 
в направлении zзадана 
равной нулю.
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На иллюстрации ниже выбрана цветовая схема 
WaveLight с симметричным диапазоном:

Мы видим поле давления в воздушной области, 
убывающее вдали от преобразователя. Но для 
того, чтобы пристальнее изучить эти волны, 
добавим специальный тип деформации, который 
называется выражением для высоты и который 
позволит нам полнее визуализировать поле 
давления в трех измерениях.

Выражения для высоты особенно полезны в тех 
случаях, когда результаты имеют волновую 
природу или когда скалярные или векторные 
величины изменяются в основном лишь 
в одном направлении. В отличие от остальных 
деформаций, которые требуют больше настроек, 
выражения для высоты — простой способ 
визуализировать пики и впадины.

Щелкните правой кнопкой мыши узел Surface (По-
верхность) и выберите Height Expression (Выражение 
для высоты). Данные будут автоматически собраны 
из родительского узла, из графика давления звука.

На вкладке Scale (Масштаб) задайте масштабный 
коэффициент, равный 0,1 или менее (вы поймете, 
зачем это нужно, если зададите большее значение, 
например 1). Затем щелкните Plot (Построить).

ОПеРАции для 
инТеРПРеТАции РезульТАТОВ
Чтобы оценить точность вашей модели, понять фи-
зические эффекты и проверить конструкцию устрой-
ства, нередко требуется решить модель несколько 
раз. Это может быть вычисление средних значений, 
поиск локальных максимумов и минимумов какой-
либо векторной величины или сверка результатов 
моделирования с экспериментальными данными.

Давайте посмотрим на операции, которые можно 
совершить с наборами данных и производными 
значениями.

СрЕДНИЕ зНА²ЕНИº

Можно вычислить средние по набору областей 
значения для какого-либо набора данных. Для де-
монстрации мы посмотрим на модель турбулент-
ного потока в трубе, хотя эти методы применимы 
ко многим типам моделей. Если у вас установлен 
модуль CFD (Вычислительная гидродинамика), 
откройте решение модели колена трубы из меню 
File > Application Libraries > CFD Module > Single-
Phase Benchmarks (Файл > Библиотеки приложе-
ний > Модуль Вычислительная гидродинамика > 
Однофазные эталонные модели).

Эта модель потока в прямом колене трубы исполь-
зует модель турбулентности κ-ω. В модели два ком-
понента; на втором из них мы остановмся подробно.

СПрАвкА

Вводная информация 
про наборы данных 
и производные значения 
приведена в разделе Data 
Sets, Derived Values, and 
Tables (Наборы данных, 
производные значения 
и таблицы) руководства 
Основы постобработки 
и визуализации в COMSOL 
Multiphysics®.

Воздушная область

Преобразователь
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Взгляните на группу графиков Pressure (spf2), ко-
торая содержит графики скорости и давления те-
кучей среды внутри трубы. На иллюстрации ниже 
мы видим линии тока, показывающие скорость 
воды. Этот график показывает зону сепарации 
после поворота и завихрения, вызванные центро-
стремительной силой.

Но допустим, к примеру, что мы хотим опреде-
лить, какой насос будет необходим для заданной 
скорости потока, или узнать, какой вклад вносит 
поворот в общее падение давления. Или, предпо-
ложим, что мы хотим измерить давление в опре-
деленной плоскости, чтобы сверить результаты 
моделирования с проектными корреляциями. 

Для этого мы можем создать секущую плоскость 
в колене, чтобы измерить, к примеру, падение 
давления между входным каналом и коленом 
и вычислить результат, используя среднее 
по поверхности.

Хотя некоторые наборы данных и вычисления 
уже готовы, мы начнем с нуля для демонстрации 
метода.

Щелкните правой кнопкой мыши Data Sets (На-
боры данных) и выберите Cut Plane (Секущая 
плоскость). Положение плоскости определяется 
длиной входной трубы, L, и радиусом поворота, 
Rc. Чтобы сориентировать плоскость перпенди-
кулярно стенкам трубы посередине поворота, 
задайте вектор нормали, равный (1,1,0).

Щелкните правой кнопкой мыши узел Derived 
Values (Производные значения) и выберите Average 
> Surface Average (Средние значения > Среднее 
по поверхности). В качестве набора данных 
укажите решение на секущей плоскости, которую 
вы только что создали. В поле Expression (Выра-
жение), введите p2 (это выражение для давления, 
используемое вторым компонентом этой модели).
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Щелкните Evaluate (Вычислить). Появившаяся 
таблица покажет давление, примерно 1970 Па.

Мы найдем давление во входном канале, исполь-
зуя другое среднее по поверхности. Добавьте вто-
рое среднее по поверхности и выберите в качестве 
набора данных Study 2/Solution 2 (3), где содер-
жится решение второго компонента. 

Затем выберите входную границу (границу 1) 
и вычислите выражение p2 еще раз.

Сравнивая эти два вычисления, мы показали, 
что падение давления между входным каналом 
и серединой поворота довольно велико — почти 
1500 Па. Если мы построим на секущей плоскости 
величину скорости потока, мы также увидим, что 
скорость очень быстро меняется в направлении 
от внешнего радиуса поворота к внутреннему. 
Это объясняет падение давления.

кОНТурНЫЕ �рА¯ИкИ

Контурные графики — один из самых быстрых 
и мощных способов проверить, выдержит 
ли устройство целевые условия эксплуатации, 
например будет ли в какой-то области устройства 
температура превышать пороговые значения или 
будет ли напряжение превышать предел прочно-
сти материала.

Мы проверим его на модели шкива, использованной 
в руководстве Основы постобработки и визуализа-
ции в COMSOL Multiphysics в которой мы познако-
мили читателей с решениями, секущими плоско-
стями и таблицами. Откройте модель, выбрав 
File > Application Libraries > COMSOL Multiphysics 
> Structural Mechanics > stresses in pulley (Файл > 
Библиотеки приложений > COMSOL Multiphysics > 
Механика конструкций > Напряжения в шкиве).

В узле Results (Результаты) есть список двумерных 
и одномерных графиков. Добавьте новую группу 
двумерных графиков и добавьте к ней контурный 
график. По умолчанию выражение будет описы-
вать смещение, испытываемое шкивом на скоро-
сти вращения 9000 об./мин. Измените выражение 
на solid.mises, чтобы увидеть напряжение по Ми-
зесу. На вкладке Coloring and Style (Цвета и стиль) 
задайте тип контура Filled (С заполнением).

НАПрº¡ЕНИЕ 
ПО МИзЕСу

Выражение для графика 
solid.mises, соответствующее 
напряжению по Мизесу, 
находится в меню Replace 
Expression > Model 1 > 
Component 1 > Solid Mechanics 
> Stress (Заменить выражение 
> Модель 1 > Компонент 1 > 
Механика твердого тела > 
Напряжение).
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Цвет на контурном графике ясно показывает 
области высоких и низких напряжений; контур 
с наибольшим значением напряжения можно ис-
пользовать, чтобы определить, выдержит ли шкив.

Чтобы увидеть точные значения на каждой границе 
контура, скопируйте этот график. В новом графике 
измените тип контура на Lines (Линии) и установите 
флажок в поле Level labels (Метки уровней) .

Затем щелкните Plot (Построить).

Новый график показывает значение вдоль 
каждого контура, с максимальным напряжением 
в самой узкой области спиц (около 63 МПа). Эти 
метки очень полезны, чтобы бегло посмотреть 
на данные; если напряжение в какой-то области 
будет слишком большим, вы это сразу заметите.

ОбµЕДИНЕНИЕ

Функция Join (Объединить) соединяет 
решения из двух наборов данных, позволяя вам 
их сравнить. Это поможет вам визуализировать 
разницу между двумя решениями, создать сводку 
с несколькими решениями или посмотреть, как 
две разных сетки влияют на результат.

Мы снова воспользуемся моделью радиатора. 
В модели, показанной ниже, мы провели пара-
метрический анализ: вычислили исследования 
при средней входной скорости, изменяющейся 
в диапазоне от 0,05 м/с до 0,5 м/с с шагом 0,05 
м/с. (Эти значения приведены здесь только для 
примера и не обязательно похожи на типичные 
значения скоростей в современных охлаждающих 
установках.)

Объединенные решения можно добавить к узлу 
Data Sets (Наборы данных). Мы возьмем новое 
исследование и сравним данные для двух разных 
скоростей. Первый набор данных — для скорости 
U0 = 0,05 (где U0 — это средняя входная скорость 
воздуха, продуваемого через радиатор). Второй 
набор данных — такой же, но для скорости U0 
= 0,5. В качестве метода объединения данных 
выберем Di�erence (Разность).
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Если мы создадим новую группу 3D-графиков 
на основе объединенных данных Join 1, мы обна-
ружим, что низкая скорость потока (U0 = 0,05 м/с) 
приводит к температуре на 64 K выше, чем высокая 
скорость потока.

Это означает, как мы и ожидали, что скорость 
потока очень сильно влияет на охлаждение, 
и моделирование позволяет численно оценить 
этот эффект. Для подобного устройства на основе 
результатов моделирования можно определить 
оптимальную скорость потока воздуха от венти-
лятора, изучив результаты распределения темпе-
ратуры при разных скоростях потока.

Наконец, заметим, что из всех методов объединения 
данных, доступных для оператора Join (Объединить), 
два заслуживают особого внимания: General (Общий) 
и Explicit (Явный). Большинство методов объедине-
ния данных — те или иные варианты метода General 
(Общий). Как если бы вы смешивали ингредиенты 
для готовки, объединенное решение не содержит ин-
формации об отдельных частях после объединения; 
это ограничивает пользователя одной независимой 
переменной для каждого решения. Если провести 
параллель с обычными функциями, мы можем вы-
числить f(v)-g(v) или f(u)-g(u), но не f(u)-g(v).

Метод Explicit (Явный) позволяет реализовать 
операции объединения, сохраняя данные отдель-
ных исходных наборов — они остаются доступ-
ными, например для построения графиков на ос-
нове объединенного решения. COMSOL создает 
два новых оператора, которые получают доступ 
к величинам из наборов данных, так что вы смо-
жете реализовать функцию f(u)-g(v) с методом 
Explicit (Явный), если только u — это допустимая 
переменная для функции f, и v — это допустимая 
переменная для функции g.

¯ИЛЬТрЫ

Иногда геометрия модели не позволит вам загля-
нуть внутрь этой модели. Однако в COMSOL есть 
легкий способ снять с нее «верхний слой» и загля-
нуть внутрь. Эта функция называется фильтром, 
и ее можно добавить к двумерным и трехмерным 
графикам (кроме графиков линий тока). 

Фильтры — более простой и вычислительно лег-
кий, если сравнить с заданием нескольких наборов 
данных с выделениями, способ ограничить ото-
бражаемое на графике выражение заданным диа-
пазоном. В процессе интерпретации результатов 
моделирования это поможет вам увидеть физиче-
ские эффекты с близкого расстояния и без помех.

В модели радиатора группа 3d-графиков 
Isothermal Contours (ht) содержит графики изопо-
верхностей, отображающие температуру. В на-
стройках графика изоповерхностей на вкладке 
Level (Уровень) число уровней задано равным 10.

Эта иллюстрация показывает изоповерхности 
температуры. Но мы не видим сам радиатор.

СОвЕТ

Как мы продемонстрировали, 
не обязательно объединять 
данные двух разных 
решателей; вы можете 
объединять наборы данных, 
чтобы изучить одно решение, 
полученное при двух разных 
значениях параметра.

СПрАвкА

Краткое объяснение поверхностей уровня приведено в разделе Plot Types (Типы 
графиков) руководства Основы постобработки и визуализации в COMSOL Multiphysics.

https://www.comsol.ru/offers/Postprocessing-and-Visualization-Handbook-Part-1-ru
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В таком случае, чтобы добавить решение, содер-
жащее только половину геометрии, нам придется 
создать секущую плоскость и аккуратно разме-
тить все выделения. Вместо этого мы воспользу-
емся фильтром.

Щелкните правой кнопкой мыши по узлу графика 
изоповерхности и выберите Filter (Фильтр). В на-
стройках фильтра вы можете выбрать логическое 
выражение, определяющее, какую область поверх-
ности графика следует отображать. Например, 
если мы зададим выражение y>0, мы исключим 
все области изоповерхности, которые лежат в от-
рицательном направлении оси y нашей коорди-
натной системы.

Выпадающий список Element nodes to ful�ll 
expression (Узлы элементов, в которых прове-
ряется выражение) предлагает выбрать, какие 
элементы сетки следует включать; по умолчанию 
включаются все элементы — вариант All (Все). 
Другие варианты:

• At least one (Хотя бы один) отобразит 
элементы хотя бы для одного узла (а, 
возможно, и для всех узлов) которых 
логическое выражение истинно

• At least one but not all (Хотя бы один, 
но не все) отобразит элементы, хотя бы 
для одного узла (но не для всех узлов) 
которых логическое выражение истинно

Пока оставьте вариант All (Все) и щелкните Plot 
(Построить).

Теперь мы видим изоповерхности температуры 
в области y>0.

Выберите в списке Element nodes to ful�ll expression 
(Узлы элементов, в которых проверяется выраже-
ние) вариант At least one but not all (Хотя бы один, 
но не все).

При этом будет отображаться область вблизи ло-
гического выражения, то есть, отображены будут 
элементы, которые пересекают линию y=0 так, что 
некоторые узлы не удовлетворяют условию y>0. 
Это может быть особенно полезно для построе-
ния графиков вблизи границ с резким перепадом 
значений.

На этом мы заканчиваем демонстрацию методов 
постобработки для интерпретации результатов; 
мы выделяли отдельные части решения, вычис-
ляли значения переменных в заданных точках 
и объединяли наборы данных. Далее мы расска-
жем об инструментах управления видом и каме-
рой в среде COMSOL.
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ИНСТРуМЕНТЫ ВИзуАлИзАцИИ
уПРАВление ВидОм 
и КАмеРОЙ
Узел View (Вид) — мощный инструмент настрой-
ки отображения объектов в графическом окне. 
Расположенные в узле De�nitions (Определения) 
настройки вида помогут вам задать нужный угол 
зрения и стиль отображения. Здесь вы можете 
добавить, повернуть или приглушить источники 
освещения, задать цвета и расположение, скрыть 
или отобразить области модели. Если провести 
параллель с театром, узел View (Вид) расставляет 
декорации на сцене, пока занавес не поднят.

Чтобы открыть узел View (Вид), относящийся 
к конкретной группе графиков, щелкните узел 
группы графиков (например, 3D Plot Group 1) 
и перейдите на вкладку Plot Settings (Настройки 
графика) В поле View (Вид) можно применить 
разные настройки вида к группе графиков или 
напрямую открыть настройки вида, нажав кнопку 
Go to Source (Перейти к коду) рядом с выпадаю-
щим списком 
Go to Source (Перейти к коду)

.

уПрАвЛЕНИЕ кАМЕрО¤  
И СО²ЕТАНИº кЛАвИ³

В узле View (Вид) расположены настройки камеры. 
По аналогии с фото- или видеосъемкой правиль-
ное положение камеры позволит вам подчеркнуть 
характерные особенности и получить прекрасный 
кадр. В COMSOL существуют сочетания клавиш 
для управления камерой, и мы приведем несколь-
ко полезных советов, которые позволят полу-
чить удачные кадры.

Откройте любую модель и щелкните узел Camera 
(Камера) в узле View 1 (Вид 1). В настройках 
камеры можно задать угол зрения, положение, 
масштаб и перспективу камеры. Вы можете пред-
ставить себе настоящую фотокамеру, стоящую 
перед графическим окном; вы смотрите на объект 
прямо через видоискатель камеры.

Это означает, что перемещаясь по графическому 
окну, вы смещаете камеру, а не саму геометрию – 
кроме случаев, когда производится операция 
с геометрией, например жесткое преобразование. 

На следующих страницах показаны часто ис-
пользуемые для ориентации камеры сочетания 
клавиш.

Иллюстрации в этом разделе показывают со-
четания клавиш на примере модели электриче-
ской шины (File > Application Libraries > COMSOL 
Multiphysics > Multiphysics > busbar (Файл > 
Библиотеки приложений > COMSOL Multiphysics 
> Мультифизические модели > Электрическая 
шина)), однако мы рекомендуем попрактиковать-
ся с сочетаниями клавиш на ваших собственных 
моделях. Вот как выглядят настройки камеры:

ПрИМЕ²АНИЕ

Для пользователей Mac: 
третье и шестое сочетания 
будут работать только 
на двухкнопочной мыши 
или на мыши с центральным 
колесом прокрутки.
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Зажмите правую кнопку мыши и потяните. Это первое сочетание сдвигает область вида влево, 
вправо, вниз или вверх вдоль плоскости видоискателя камеры (плоскости графического окна). При 
этом меняется View O set (Смещение вида).

ДЕЙСТВИЕ

СОЧЕТАНИЕ КАМЕРА

Сдвинуть область вида на плоскости графического окна.

Действие Результат

Было

СМЕЩЕНИЕ ВИДА

ВВЕРХ

ВПРАВОВЛЕВО

ВНИЗ

Стало
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Зажмите левую кнопку мыши и потяните, удерживая клавишу Alt. Это сочетание вращает камеру 
вокруг оси, перпендикулярной плоскости графического окна.

ДЕЙСТВИЕ

СОЧЕТАНИЕ КАМЕРА

Вращать камеру.

Действие Результат

Было

НАПРАВЛЕНИЕ ВВЕРХ

Используйте клавишу Alt

ВРАЩЕНИЕ

ВРАЩЕНИЕ

ВРАЩЕНИЕ

ВРАЩЕНИЕ Стало
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Зажмите колесо прокрутки и потяните. Еще одно простое действие — приближение или 
удаление области, где расположен указатель мыши. Кнопки изменения масштаба в графических 
инструментах тоже легко доступны, но они приближают центр видимого окна с определенным шагом 
и не управляются указателем мыши: Это сочетание позволяет более точно контролировать увеличение.

ДЕЙСТВИЕ

СОЧЕТАНИЕ КАМЕРА

Приблизить или отдалить область, где расположен указатель мыши.

Действие Результат

Было

УГОЛ ОБЗОРА

СталоПРИБЛИЗИТЬ

ОТДАЛИТЬПРИБЛИЗИТЬ

ОТДАЛИТЬ

Щелкните и удерживайте 
среднюю кнопку мыши.
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Зажмите левую клавишу мыши и потяните, удерживая клавишу Ctrl. Это сочетание меняет 
наклон и панораму камеры. При этом меняется положение камеры и угол, под которым камера видит 
геометрию компонентов (в отличие от первого сочетания, смещающее видимую область в плоскости 
видоискателя камеры). Оранжевая пиктограмма показывает, куда направлена камера. Так как это 
сочетание двигает и вращает камеру относительно геометрии компонентов, вы увидите, что модель 
двигается в направлении, противоположном движению мыши.

ДЕЙСТВИЕ

СОЧЕТАНИЕ КАМЕРА

Изменить наклон и панораму камеры, не меняя ее расположения.

Действие Результат

Было

НАПРАВЛЕНИЕ

СталоНАКЛОНИТЬ 
КАМЕРУ ВВЕРХ

ПОВЕРНУТЬ 
ПАНОРАМУ 
ВПРАВО

ПОВЕРНУТЬ 
ПАНОРАМУ 

ВПРАВО

НАКЛОНИТЬ 
КАМЕРУ ВНИЗ

Используйте клавишу Control
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Зажмите правую кнопку мыши и потяните, удерживая клавишу Ctrl. Это сочетание перемещает 
камеру вверх, вниз, влево или вправо, не меняя ее ориентацию. Камера смещается относительно 
геометрии компонентов, так что вы увидите, что геометрия смещается в противоположном камере 
направлении (но в том же направлении, куда двигается мышь).

ДЕЙСТВИЕ

СОЧЕТАНИЕ КАМЕРА

Сдвинуть камеру вверх/вниз/вправо/влево.

Действие Результат

Было

ПОЛОЖЕНИЕ

НАПРАВЛЕНИЕ

Стало

СДВИНУТЬ 
КАМЕРУ ВВЕРХ

СДВИНУТЬ 
КАМЕРУ 
ВЛЕВО

СДВИНУТЬ 
КАМЕРУ 
ВПРАВО

СДВИНУТЬ 
КАМЕРУ ВНИЗ

Используйте клавишу Control
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Зажмите колесо прокрутки и потяните, удерживая клавишу Alt. Последнее сочетание оставляет 
геометрию компонентов в центре видимой области и смещает камеру ближе или дальше к геометрии. 
В отличие от масштаба, это действие не зависит от положения указателя мыши и не меняет угол обзора 
камеры. 

ДЕЙСТВИЕ

СОЧЕТАНИЕ КАМЕРА

Переместить камеру ближе к центру модели или дальше от него.

Действие Результат

Было

ПОЛОЖЕНИЕ

НАПРАВЛЕНИЕ

Стало
ПЕРЕМЕСТИТЬ 

КАМЕРУ БЛИЖЕ

ПЕРЕМЕСТИТЬ 
КАМЕРУ 
ДАЛЬШЕ

ПЕРЕМЕСТИТЬ 
КАМЕРУ 
БЛИЖЕ

ПЕРЕМЕСТИТЬ 
КАМЕРУ ДАЛЬШЕ

Используйте клавишу Alt

Щелкните и удерживайте колесо прокрутки.
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ОСВещение и СценА
Освещение поможет вам подсветить области 
модели, которые сложно разглядеть, представляя 
вам новую точку зрения на визуализацию резуль-
татов. Эти мелкие штрихи могут показать ваше 
устройство в совершенно новом свете.

Чтобы поэкспериментировать с настройками 
освещения и сцены в COMSOL, мы воспользуемся 
моделью поршневого двигателя. Если у вас установ-
лен модуль Multibody Dynamics (Динамика много-
тельных систем), эту модель вы найдете в меню File 
> Application Libraries > Multibody Dynamics Module > 
Automotive and Aerospace (Файл > Библиотеки при-
ложений > Модуль Динамика многотельных систем 
> Автомобильная и авиакосмическая промышлен-
ность). (Если в вашей библиотеке нет модели с го-
товыми решениями, загрузите ее через меню File 
> Help > Update COMSOL Application Library (Файл 
> Справка > Обновить Библиотеку приложений 
COMSOL).) Показанные ниже методы применимы 
к любой геометрии, однако мы возьмем модель 
двигателя, на изгибах которой эффекты освещения 
будут особенно заметны.

Эта учебная модель рассчитывает динамику 
многотельных структур в трехцилиндровом 
поршневом двигателе и термодинамику воз-
душно-топливной смеси в цилиндрах. Резуль-
таты моделирования используются для расчета 
колебаний давления в камере сгорания, скорости 
вращения в оборотах в минуту, движения раз-
личных деталей сборки и выходной мощности 
цилиндров. Геометрия включает в себя маховик, 
коленчатый вал, цапфу, кривошип и поршень 
в каждом из трех цилиндров.

В этой модели два компонента. Мы будем 
работать со вторым компонентом — Multibody 
Analysis, анализом динамики многотельных 
структур.

Чтобы создать для этой модели нужное 
освещение, нам понадобится несколько 
разнонаправленных источников света.

В узле Results (Результаты) разверните группу 
графиков Displacement (Смещение). Этот график 
показывает смещение разных деталей во время 
работы двигателя. Если вы развернете подузел 
Surface 1 (Поверхность 1), вы увидите деформа-
цию. Эта деформация смещает видимую геоме-
трию в положение двигателя на отметке времени 
0,16 секунды, но оставляет контур исходного 
положения.

Перейдите к узлу View (Вид) группы графиков 
Displacement (Смещение). После ознакомления 
с уже существующими источниками света и узлом 
Hide Geometric Entities 1 (Скрыть геометрические 
объекты 1), который скрывает поршень среднего 
цилиндра, удалите Directional Lights (Направлен-
ные источники света) 1, 2 и 3.

Если вы вернетесь к графику смещения, 
вы увидите темный, неосвещенный двигатель, 
как на иллюстрации ниже. В узле View (Вид) 
геометрия должна быть серой.

Щелкните правой кнопкой мыши View 2 (Вид 2) 
и выберите Directional Light (Направленный ис-
точник света). В графическом окне появится 
новый источник света, изображаемый стрелкой 
внутри тетраэдра и направленный вдоль (0,0,0).

Положение направленных источников света за-
дается их направлением; они ведут себя как лучи 
солнца, освещая все области модели на своем 
пути и останавливаясь на стенах и выступах. В от-
личие от зональных источников света, о которых 
мы поговорим позже, положение направленного 
источника света изменить нельзя.

СОвЕТ

Геометрия поршневого 
двигателя с большим 
количеством изогнутых 
поверхностей хорошо 
подходит для опытов 
с освещением. Подробнее 
о создании рисунка 
с иллюстрации ниже 
рассказано на странице 
29 в разделе Советы 
и рекомендации для опытных 
пользователей.

Коленчатый вал Маховик

Кривошип

Цапфа

Шатун

Цилиндр

Поршень
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Поиграйте с разными значениями координат 
на вкладке Direction (Направление) настроек 
источника света. Когда вы поймете, как освеще-
ние меняется с изменением координат, создайте 
второй направленный источник света. Мы под-
светим несколько областей двигателя.

Нам также понадобится один источник света, 
чтобы ярким пятном осветить всю сцену. Позже 
мы добавим третий источник для верхней 
стороны и боков, и еще один, чтобы подчеркнуть 
изогнутые поверхности.

Задайте координаты направления для первого 
источника (3,3,0) и интенсивность освещения, 
равную 0,75. Этот источник осветит большую 
часть геометрии.

На втором источнике света мы проверим, что 
будет, если изменить координаты — попробуйте 
осветить верхнюю, нижнюю или боковую сторо-
ны двигателя. Для иллюстрации ниже мы исполь-
зовали координаты (-0,5,1,-1).

Когда вы нашли удовлетворительное положение для 
источников освещения, добавьте третий направлен-
ный источник света. Его мы используем для изогну-
тых поверхностей: Координаты третьего источника 
на иллюстрации ниже (1,1,1), но вы можете выбрать 
для него позицию на свое усмотрение.

СОвЕТ

При редактировании освещения уже созданной модели мы рекомендуем не исполь-
зовать более одного источника света одновременно. Такой подход позволит наглядно 
увидеть, какие эффекты вызывает добавление к сцене того или иного источника света. 
Вы можете также раскрыть вкладку Light (Свет) в настройках основного узла View 
(Вид), чтобы изменить интенсивность фонового освещения и всего освещения сцены. 
Работая в узле View (Вид), вы заметите, что все источники света изображены стрелками, 
а редактируемый в данный момент источник — стрелкой в тетраэдре.
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Направленные источники света, которые мы до-
бавляли, используются чаще всего, но в COMSOL 
включены еще несколько типов источников света. 
Если вы снова щелкнете правой кнопкой мыши 
узел View 2 (Вид 2), вы можете добавить точеч-
ный, зональный или лобовой источник света.

Точечный источник света похож на лампочку: 
он светит во всех направлениях, и вы можете 
изменять его положение. Этот точечный источник 
расположен в точке (-0,25, -0,5, -0,25):

Зональный источник света похож на фонарик: 
пользователь задает и его направление, и его 
положение. Этот зональный источник света рас-
положен в точке (-0,28, -0,33, 0) и направлен вдоль 
вектора (1,1,-0,75):

Лобовой источник света направлен от положе-
ния камеры и жестко привязан к системе коорди-
нат камеры, так что вы не можете изменить ни его 
положение, ни его направление.

На этом обзор доступных в COMSOL инструмен-
тов управления камерой и освещением завершен. 
При помощи этих инструментов вы сможете 
выделить самые важные области ваших графи-
ков и подготовить информативные визуальные 
отчеты, которые позволят получить подробное 
представление о происходящих в вашей модели 
процессах.
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Некоторые виды графиков особенно полезны для 
отдельных физических задач, так что они чаще 
всего используются с теми модулями расширения 
программного пакета COMSOL, которые относят-
ся к этой физической задаче. Сделаем небольшое 
отступление и посмотрим, какие графики нужны 
для отдельных физических задач.

ГРАФиКи В дАльнеЙ зОне
В задачах радиочастотного диапазона моделируется 
излучение и поглощение электромагнитных волн 
высокой частоты. Моделирование можно использо-
вать для проектирования различных радиочастот-
ных устройств, и один из наиболее часто при-
нимаемых во внимание инженерами показателей 
качества — диаграмма направленности излучения. 
В контексте радиочастотного и микроволнового 
оборудования моделирование может быть приме-
нено относительно таких устройств, как антенны.

Рассмотрим учебную модель радиочастотного 
устройства, для которого нам нужно узнать диа-
грамму направленности излучения.

Ниже показана модель интегрированного в под-
ложку волновода, который применяется в кон-
струкции антенн. Волны излучаются из щелей 
вверху и формируют поток, направление которо-
го регулируется рабочей частотой.

В этой модели, доступной в меню File > Application 
Libraries > RF Module > Antennas (Файл > Библиотеки 
приложений > Модуль Радиочастоты > Антенны), 
если у вас установлен модуль RF (Радиочастоты), 
вычисления в дальней зоне применяются для 
расчета распределения электромагнитного поля 
на значительном удалении от волновода. 

Графики в дальней зоне применяются для ото-
бражения глобальных переменных в дальней зоне 
электромагнитных полей или полей давления, так 
что те инструменты визуализации, которые мы 
используем для волновода, также подойдут для 
многих задач радиофизики и акустики.

На графике в дальней зоне переменная строится для 
определенного диапазона углов (Θ и ϕ в настройках 
ниже), и в каждой расчетной точке исходная сфери-
ческая поверхность деформируется в радиальном 
направлении, создавая поверхность графика. 

Преимущество графиков в дальней зоне состоит 
в том, что деформированная сфера не относится 
к геометрии модели, так что число построенных 
направлений не связано с дискретизацией обла-
сти определения решения. Форма деформирован-
ной сферы зависит от указанного выражения для 
расчетных точек.

Настройки графика в дальней зоне для модели 
волновода приведены ниже.

СПЕцИАлИзИРОВАННЫЕ ГРАФИКИ  
Для ОТДЕльНЫХ ФИзИЧЕСКИХ зАДАЧ

Сосредото-
ченный порт 1

Сосредоточенный порт 2
Круглая щель для согласования 
полного сопротивления

Щели, пропускающие 
излучаемые волны

Металлизированные 
перемычки

Подложка толщиной 60 мм 
с нижней заземляющей 
плоскостью
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В этой модели волновода мы можем построить 
график нормы поля дальней зоны, emw.normEfar. 
График, приведенный ниже, увеличен, чтобы 
были лучше видны детали; на нем показана норма 
электрического поля в дальней зоне для рабочей 
частоты в 12,25 ГГц.

Увеличив угловое разрешение, вы получите более 
гладкую и четкую картину поля в дальней зоне. 
На иллюстрации ниже волновод смещен вниз 
жестким параллельным переносом, чтобы мы 
могли увидеть диаграмму направленности излу-
чения в дальней зоне целиком.

Максимальное разрешение по переменным Θ и ϕ — 
180 (как показано выше). Как можно ожидать, чем 
выше разрешение, тем сложнее в вычислительном 
отношении становится задача постобработки.

ТРАССиРОВКА чАСТиц
Модуль Трассировка частиц используется для 
решения набора обыкновенных дифференциальных 
уравнений движения различных частиц. На движе-
ние частиц оказывают влияние различные внешние 
силы, такие как сила действия электромагнитного 
поля, сила сопротивления и диэлектрофоретиче-
ская сила. Различные способы позволяют учесть 
взаимодействия частиц с границами, с другими 
частицами и с полем. Интерфейсы физик полезны 
в моделировании самых различных задач, напри-
мер переноса ионов в электромагнитных полях, 
движения планет или разделения живых клеток 

в микрогидродинамических системах. Мы покажем 
некоторые методы постобработки с помощью моду-
ля Трассировка частиц на примере модели статиче-
ского смесителя.

Если у вас установлен модуль Трассировка частиц, 
откройте учебную модель в меню Application Libraries 
> Particle Tracing Module > Fluid Flow > laminar mixer 
particle (Библиотеки приложений > Модуль Трасси-
ровка частиц > Поток текучей среды > Ламинарный 
смеситель, частицы). Геометрия задана каналом 
с рядом закрепленных лопастей, изогнутых в разные 
стороны. В этом примере мы оцениваем характеристи-
ки смесителя, вычисляя траектории твердых частиц, 
переносимых потоком воды через лопасти смесителя.

Мы начнем с некоторых графиков, которые вклю-
чены в эту учебную модель. Щелкните группу 
3d-графиков под названием Particle Trajectories 
(fpt) (Траектории частиц). Этот график изобра-
жает траектории частиц до выбранного момента 
времени, а цветом показана скорость сдвига 
в текущих положениях частиц.

Параметры этого графика можно с легкостью 
откорректировать, благодаря чему становится воз-
можной визуализация продвижения частиц в раз-
личные моменты времени. Ряд иллюстраций ниже 
показывает траектории в три момента времени: t = 
1 с (вверху), t = 1,6 с (в центре) и t = 3 с (внизу), где 
выражение для цвета заменено на spf.U, чтобы по-
казать величину скорости частиц. Чтобы вручную 
настроить диапазон цветовой шкалы, разверните 
вкладку Range (Диапазон) в настройках подузла 
Color Expression 1 (Выражение для цвета 1).

АкуСТИ²ЕСкОЕ 
МОДЕЛИрОвАНИЕ

Таким же методом 
можно воспользоваться 
при акустическом 
моделировании, чтобы 
визуализировать давление 
звука вдали от моделируемого 
объекта. На примере 
ниже показаны уровни 
давления звука в дальней 
зоне вокруг грибовидного 
пьезоэлектрического 
преобразователя. Такие 
устройства, например, 
используются в сонарных 
системах для генерации 
низкочастотных звуковых 
волн высокой мощности.
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График траекторий частиц дает более реалистич-
ное представление о перемешивании текучей 
среды, чем график линий тока. Графики линий тока 
используют для визуализации векторных величин, 
строя касательные к кривым мгновенного вектор-
ного поля (краткое описание графиков линий тока 
приведено в разделе Типы графиков руководства 
Основы постобработки и визуализации в COMSOL 
Multiphysics ). Трассировка частиц для интерфейса 
физик Fluid Flow (Поток текучей среды), напротив, 
рассматривает частицы как отдельные объек-
ты, а не как непрерывное поле, и решает набор 
обыкновенных дифференциальных уравнений для 
каждой частицы, точно учитывая инерцию частиц.

Другой полезный метод для визуализации смеши-
вания частиц — фазовый портрет. На фазовом пор-
трете каждая частица изображается цветной точкой 
со своими координатами в заданном пользователем 
фазовом пространстве. Например, двумя осями 
координат могут быть две координаты положения 
частицы, либо же вдоль одной оси можно отложить 
положение частицы, а вдоль второй — ее скорость.

Щелкните группу двумерных графиков 2D Plot 
Group 5, в которой есть график Phase Portrait 1 
(Фазовый портрет 1). В этом примере в качестве 
двух координат фазового портрета выбраны две 
поперечных координаты положения частицы.

Значение времени можно настроить на вкладке 
Data (Данные) окна настроек Phase Portrait (фа-
зового портрета). Ниже показаны три фазовых 
портрета в моменты времени t = 0 с (слева), t = 1 с 
(в центре) и t = 4,2 с (справа). Цветом обозначено 
начальное положение каждой частицы. В конеч-
ный момент времени мы все еще видим отдель-
ные участки, состоящие только из красных или 
только из синих частиц. Это указывает на то, что 
текучая среда еще не перемешана до конца.

Основной недостаток фазового портрета в том, 
что на нем строятся положения частиц в фазовом 
пространстве в определенный момент времени, 
а не в определенной точке вдоль оси смесителя. 
Для того, чтобы лучше оценить перемешивание 
в определенных точках геометрии смесителя, стоит 
использовать карту Пуанкаре. Этот график пока-
зывает координаты, в которых частицы пересекают 
одну или несколько поверхностей, определенных 
в наборе данных Cut Plane (Секущая плоскость).

Щелкните группу 3d-графиков 3D Plot Group 4. 
На этом графике мы видим группы частиц на раз-
ных плоскостях после смешивания, и мы можем 
заметить, что даже в выходном канале частицы 
не полностью перемешаны. Эта карта Пуанкаре 
построена на плоскостях на отметках 0,006, 0,016, 
0,026, 0,036 и 0,042 м вдоль оси y.

На этом мы заканчиваем раздел о специализирован-
ных графиках для определенных физических задач.

СЕку´ИЕ ПЛОСкОСТИ

Чтобы построить график на секущей 
плоскости, мы используем наборы 
данных Cut Plane (Секущая плоскость), 
которые создаются из трехмерных 
наборов данных и могут быть 
визуализированы как группы 2d- 
или 3d-графиков. Из плоскости 
сечения можно создать несколько 
параллельных плоскостей. Установите 
флажок в поле Additional parallel planes 
(Добавочные параллельные плоскости) 
и выберите расстояние или диапазон 
сдвигов дополнительных плоскостей, 
как показано на иллюстрации справа.
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идеи для эФФеКТнЫх 
ВизуАлизАциЙ
В этой секции мы предложим вам различные 
способы для создания уникальных визуализаций. 
Мы продемонстрируем примеры методов, кото-
рые помогут вам посмотреть на ваши результаты 
свежим взглядом. Речь пойдет о деформациях, 
секущих плоскостях, различных комбинациях 
графиков и расширенных методах управления 
камерой.

СЕку´ИЕ ПЛОСкОСТИ И ЛИНИИ

В руководстве Основы постобработки и визу-
ализации в COMSOL Multiphysics мы кратко 
описали, как использовать секущие плоскости (и, 
по аналогии, секущие линии), чтобы отобразить 
результаты на плоскости или линии, проходящей 
через геометрию модели. В COMSOL эти графики 
можно объединить, значительно улучшая и упро-
щая представление результатов.

В прошлый раз мы создали линейный график, 
который проходил через модель радиатора 
вдоль оси x и показывал температуру воздуха 
и скорость потока в канале. Линейный график, 
показанный ниже, деформирован в соответствии 
с полем скоростей (u,v,w), величина которого 
также управляет радиусом трубок.

Мы также можем добавить к деформированным 
линиям стрелочный график, чтобы отобразить 
поле скоростей. Цвет стрелок на графике ниже 
зависит от величины скорости, spf.U.

Возможно, вам непросто заметить, что происхо-
дит вблизи ребер радиатора, поскольку там очень 
много линий. Давайте создадим новый набор 
данных для графика в разрезе — поперечного се-
чения радиатора и канала, в котором лучше будет 
видна область вблизи ребер.

Щелкните правой кнопкой мыши узел Data Sets 
(Наборы данных) и добавьте секущую плоскость. 
На вкладке Plane Data (Данные плоскости), задайте 
в поле Plane (Плоскость) вариант xz-плоскостей. 
Щелкните Plot (Построить). С координатами 
по умолчанию это действие построит плоскость, 
проходящую через центр канала и радиатора.

Теперь щелкните узел Data Sets (Наборы данных) 
и выберите Cut Line 2D (Двухмерная секущая 
линия). В качестве набора данных укажите только 
что созданную секущую плоскость (Cut Plane 1). 
Задайте координаты точки Point 2, равные (1,0). 
Установите флажок в поле Additional parallel lines 
(Добавочные параллельные линии) .

СОВЕТЫ И РЕКОМЕНДАцИИ Для ОПЫТНЫХ 
ПОльзОВАТЕлЕЙ

СПрАвкА

В разделе Наборы данных, производные значения и таблицы руководства 
Основы постобработки и визуализации в COMSOL Multiphysics описаны 
секущие точки, секущие линии и секущие плоскости. 

https://www.comsol.ru/offers/Postprocessing-and-Visualization-Handbook-Part-1-ru
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Здесь мы укажем диапазон значений для создания 
ряда вертикальных секущих линий, лежащих 
в новой плоскости. Нажмите кнопку Range  
(Диапазон)  рядом с полем Distances (Расстояния), 
чтобы открыть диалоговое окно ввода диапазона. 
Введите следующие значения:

• Start (Начало): 0,01

• Step (Шаг): 0,006 (создавать линии через 
каждые 6 мм от начальной точки)

• Stop (Конец): 0,04

Щелкните Add (Добавить), и диапазон будет 
добавлен в поле Distances (Расстояния). 

Щелкните Plot (Построить), чтобы отобразить 
секущие линии на разрезе, созданном секущей 
плоскостью.

Теперь добавим новую группу двумерных 
графиков к узлу Results (Результаты), используя 
набор данных с плоскости Cut Plane 1. Добавим 
линейный график и стрелочный график.

В линейном графике воспользуйтесь набором 
данных Cut Line 2D 1 (решение вдоль только 
что созданной секущей линии) и постройте 
выражение spf.U (величину скорости). Задайте 
тип линии Tube (Трубка) и задайте выражение для 
радиуса трубки, spf.U .

Добавьте к этому графику деформацию, устано-
вив координату xравной компоненте u, а коор-
динату yравной компоненте v (компоненты поля 
скоростей).

В стрелочном графике задайте набор данных Cut 
Line 2D 1 (Двухмерная секущая линия 1) и мас-
штабный коэффициент, равный 0,025; в качестве 
выражения должно быть автоматически подстав-
лено поле скоростей.

Щелкните Plot (Построить). Мы получили 
двумерное поперечное сечение, эквивалентное 
исходному трехмерному графику.

Хотя на трехмерном графике некоторые детали 
решения могут быть видны лучше, на этом 
графике гораздо проще увидеть, как поток 
воздуха вдоль заданной плоскости меняется при 
прохождении через радиатор.

ДЕ¯ОрМАЦИИ ДЛº НАЛО¡ЕНИº 
рЕзуЛЬТАТОв

Мы еще не затрагивали тему использования 
деформации для сравнения результатов в преде-
лах одного графика. Она позволяет одновременно 
оценить несколько разных величин. Мы использу-
ем несколько разных графиков, показывающих две 
и более величины.

Приведем для иллюстрации трехмерный пример. 
Если у вас установлен модуль Heat Transfer (Те-
плопередача), откройте модель нагревательного 
контура из меню File > Application Libraries > Heat 
Transfer Module > Power Electronics and Electronic 
Cooling (Файл > Библиотеки приложений > Модуль 
Теплопередача > Силовая электроника и охлажде-
ние электронных приборов).

Нагревательные контуры все шире применяются 
в разных сферах, особенно в промышленном про-
изводстве. Это устройство включает в себя слой 
электрического сопротивления на стеклянной под-
ложке, который испытывает джоулев нагрев при 
приложении электрического напряжения. В реше-
нии модели есть графики, показывающие механи-
ческое напряжение, изоповерхности температуры, 
температуру, электрический потенциал и поверх-
ностные потери в нагревательном контуре.

Допустим, что мы хотим визуализировать 
несколько результатов одновременно, выстраивая 
данные в один массив. Для создания массива 
мы можем использовать существующие группы 
графиков. 

СТрЕЛО²НЫЕ �рА¯ИкИ

Точно так же, как стрелочный 
график скалярного поля 
отображает векторную 
величину с помощью стрелок 
на плоской поверхности, 
стрелочный линейный 
график использует для показа 
величины стрелки на линиях.
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Новая группа графиков будет включать в себя 
поверхности из групп графиков Stress (solid), 
Temperature (ht), Electric Potential (ecs) и Surface 
Losses, разделенные пробелами шириной 50 мм 
вдоль оси z:

Для начала раскройте узел Stress (solid) и взгляните 
на заданную там деформацию, которая искривляет 
геометрию объекта в соответствии с полем смещения.

Создайте новую группу 3d-графиков. Щелкните 
правой кнопкой мыши график скалярного 
поля в группе Stress (solid) и выберите Copy 
(Копировать). (Деформация, как подузел этого 
узла, также будет скопирована.) Щелкните правой 
кнопкой мыши вашу новую группу графиков 
и выберите Paste Surface (Вставить поверхность).

Таким же образом скопируйте поверхности из узла 
Temperature (ht). Когда вы вставите ее в вашу новую 
группу графиков, не спешите добавлять новую 
деформацию. Сначала на вкладке Title (Заголовок) 
измените тип заголовка на None (Нет), а на вкладке 
Coloring and Style (Цвета и стиль) снимите 
флажок в поле Color legend (Цветовые условные 
обозначения) (это делается для того, чтобы при 
копировании областей не сливать в один график 
несколько заголовков и условных обозначений, 
которые заполнят ваше графическое окно).

Теперь добавьте деформацию к графику темпера-
туры. На иллюстрации ниже график смещен вниз 
на -50 мм в направлении оси z. Задайте масштаб-
ный коэффициент, равный 1, и установите компо-
ненты x и y, равные нулю.

Массив графиков сначала будет выглядеть раз-
мытым:

Мы добавим к поверхности температуры линей-
ный график, который поможет нам различать 
разные области устройства.

Перейдите к узлу Data Sets (Наборы данных) 
и продублируйте решение Study 1/Solution 1 (1). 
Появится набор данных под названием Study 1/
Solution 1 (3). Добавьте выделение, которое будет 
включать все грани графика (выберите Edge 
(грани) в поле геометрических объектов, а затем 
выберите All edges (Все грани) в поле выделения).

Теперь добавьте к вашей группе 3d-графиков линейный 
график с набором данных Study 1/Solution 1 (3). Задайте 
выражение, равное 1, и равномерно черный цвет.

Вы не заметите никаких изменений, потому что 
ваш график не содержит деформаций, добавленных 
к графику температуры, так что он точно совпадает 
с линиями поверхности механического напряжения.

Скопируйте узел деформации из поверхности тем-
пературы и вставьте его в линейный график, чтобы 
сместить грани графика. Щелкните Plot (Построить).

Есть несколько способов завершить построение 
этого массива, но обычно проще продублировать 
уже существующие поверхности, чем копировать 
все данные из других групп графиков. Создайте 
еще два графика поверхности: один для электри-
ческого потенциала и один для поверхностных 
потерь. В таблице ниже приведены выражения 
и деформации, которые мы использовали для по-
строения, но вы можете изменить в соответствии 
со своими предпочтениями:

График Выражение Деформация

Поверхностные 
потери

ecs.Qsh -100

Электрический 
потенциал

V -150

СДвИ�И

К каждому графику 
поверхности вы можете 
применить только одну 
деформацию. Поэтому 
график, содержащий 
деформацию смещения 
в контуре, мы не можем 
сдвинуть вдоль оси z. Все 
остальные поверхности 
мы сдвигаем вдоль оси z 
при помощи деформаций.
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В руководстве Основы постобработки и визуализа-
ции в COMSOL Multiphysics мы изучили примеры 
одновременного построения нескольких поверхно-
стей на модели. Для эффектной визуализации вы, 
возможно, захотите отобразить три, четыре, или 
пять поверхностей на вашей геометрии. Но как при 
этом сделать визуализацию понятной и читаемой?

Изображение поршневого двигателя, которое мы 
видели в разделе Инструменты визуализации, — 
это комбинация графиков поверхности, линейных 
графиков, деформаций, каркасных изображений 
и разных цветовых схем.

Только одна поверхность на этой иллюстра-
ции — один из шатунов двигателя — раскрашена. 
Остальные области двигателя переданы в оттен-
ках серого, с сеткой на одной из областей.

На итоговом графике есть

• График скалярного поля, исключающий 
средний поршень, средний цилиндр 
и левый цилиндр. Цветовая схема — 
однородный светлый металлический 
серый цвет. К поверхности применена 
деформация с компонентами (u, v, w), 
которая повторяется на остальных гра-
фиках и показывает положение в момент 
времени t = 0,16 с.

• График скалярного поля, содержащий дан-
ные только о среднем шатуне. Этот график 
показывает напряжение по Мизесу.

• Линейный график, показывающий все 
ребра из набора данных. К этому графику 
не применена деформация, так что он по-
казывает исходное положение двигателя.

• График скалярного поля, содержащий 
данные только о самом левом кривошипе, 
цапфе и головке шатуна, к которому при-
менено каркасное отображение с черным 
цветом, чтобы показать ребра элементов 
сетки.

ПрИМЕрЫ рАС³ИрЕННО�О уПрАвЛЕНИº 
НАСТрО¤кАМИ кАМЕрЫ

Камера может помочь вам найти интересную точку 
зрения на модель. Хотите ли вы поближе взглянуть 
на сетку, увидеть пересечение двух поверхностей 
или подробно изучить границу, такие кадры 
проливают новый свет на вашу визуализацию 
и позволяют вам взглянуть на модель изнутри.

Следующие примеры, созданные с помощью ряда 
поворотов и приближений, показывают различные 
ракурсы.

На иллюстрации ниже модель колец Гельмгольца 
с линиями тока, показывающими магнитное поле. 
Такой кадр был создан с помощью изменения 
панорамы, наклона, масштаба и расстояния камеры 
и сдвига камеры в плоскости (сочетания клавиш 
3–6 из раздела Инструменты визуализации ).

кАркАСНЫ¤  
рЕНДЕрИН�

Чтобы показать на графике 
элементы сетки, добавьте 
к группе графиков новую 
поверхность и залейте 
ее однородным черным 
цветом. В настройках 
поверхности установите 
флажок в поле Wireframe 
(Каркас) на вкладке Coloring 
and Style (Цвета и стиль). Такой 
прием обычно используется 
для наложения сетки 
на поверхность другого цвета.
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Вверху вы видите кожухотрубный теплообменник 
с линиями тока текучей среды. На этой иллюстрации 
есть график линий тока, график поверхности, стре-
лочный график и каркасная сетка. Кадр справа был 
создан с помощью ряда вращений и приближений.

Кадр вверху снят с р, расположенной между 
ребрами радиатора, и показывает поверхности 
и линии тока. Чтобы достичь такого ракурса, 
камеру пришлось спустить к основанию ребер, 
и придвинуть, а также приблизить кадр, исполь-
зуя масштабирование щелчком колеса прокрутки.

Вверху вы видите ножки биодатчика и изобра-
жение скорости текучей среды. Для такого кадра 
камеру нужно повернуть и придвинуть, а также 
приблизить кадр.

АнимАция
Один из последних методов, которых мы здесь 
коснемся, связан с экспортом результатов. 
Их можно экспортировать в виде графиков, 
таблиц, анимаций и отчетов. Некоторые методы 
экспорта данных и создания результатов обсуж-
дались в разделе Экспорт результатов руко-
водства Основы постобработки и визуализации 
в COMSOL Multiphysics. В этом разделе мы пого-
ворим об анимации.

Воспользуемся моделью ламинарного смесителя, 
хотя эту технику можно применять к любым моде-
лям и исследованиям с временной зависимостью. 
Щелкните правой кнопкой мыши узел Export (Экс-
порт) под всеми группами графиков в узле Results 
(Результаты) и выберите Animation > Play (Анимация 
> Воспроизвести). Проигрыватель создает инте-
рактивную анимацию непосредственно в среде 
COMSOL Desktop®. На вкладке Scene (Сцена) вы-
берите Particle Trajectories (fpt) (Траектории частиц)
в качестве предмета анимации.

При нажатии кнопки Play (Воспроизвести) в пане-
ли инструментов графического окна, вы увидите 
траектории частиц, появляющиеся во входном 
канале и двигающиеся через смеситель к выходно-
му каналу. В настройках проигрывателя вы можете 
изменить число кадров и скорость анимации.
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Вот снимок в процессе:

Снова щелкните правой кнопкой мыши узел 
Export (Экспорт) и выберите Animation > File 
(Анимация > В файл). Здесь вы можете экспорти-
ровать видео или сохранить последовательность 
изображений в файл — прекрасный вариант для 
того, чтобы быстро проемонстрировать результат 
вашей работы в презентации или на веб-сайте.

Снова выберите Particle Trajectories (fpt) (Траектории 
частиц) в качестве предмета анимации, введите 
имя файла в поле Filename (Имя файла) на вклад-
ке Output (Вывод) и настройте показ анимации 
в соответствии со своими предпочтениями. Затем 
щелкните Export (Экспортировать) в верхней части 
окна настроек, чтобы записать видео. Файл можно 
просмотреть в браузере или проигрывателе, под-
держивающих формат GIF..

ОТРиСОВКА и СГлАЖиВАние
Если вы щелкнете любой узел графика из тех, ко-
торые мы строили в этом руководстве, вы увидите 
раздел Quality (Качество) в нижней части окна 
настроек, под вкладкой Coloring and Style (Цвета 
и стили). На вкладке Quality (Качество) вы може-
те настроить разрешение графиков, сделать их не-
прерывными с помощью сглаживания и включить 
точное восстановление производных.

ИзМЕЛЬ²ЕНИЕ СЕТкИ

Когда мы изучали модель радиатора в руководстве 
Основы постобработки и визуализации 
в COMSOL Multiphysics, мы отображали изменение 

температуры на задней границе воздушной области 
с помощью контурного графика. В том примере для 
сглаживания изображений мы применяли мелкую 
сетку, а также производили ее измельчение.

По умолчанию для графика выбрана настройка раз-
решения Normal (Нормальное). Любое разрешение 
выше уровня No re�nement (Без измельчения) будет 
означать, что элементы сетки во время отрисовки 
можно разбивать на более мелкие части.

Обратите внимание на разницу между контурами 
без измельчения (слева) и с высоким измельчением 
(справа) на иллюстрации ниже:

Увеличение разрешения хорошо работает в случаях, 
когда для увеличения точности непрерывного ре-
шения модели не нужна более мелкая сетка. С высо-
кими значениями измельчения отображаемое поле 
отрисовывается по большему числу точек в каждом 
элементе сетки, что улучшает отображение гладких 
полей. 

В таких случаях, как в этом примере с сопряженной 
теплопередачей, измельчение работает хорошо; 
измельчение отображения непрерывного распре-
деления температуры не влияет на корректную 
отрисовку результатов.

Если же, с другой стороны, отображаемая величи-
на быстро меняется или даже имеет разрыв вну-
три элемента сетки, измельчение сетки, вероятно, 
приведет к появлению всплесков и колебаний. 
Поэтому до проведения измельчение нужно из-
учить отрисовку вашего решения и найти такие 
настройки, которые улучшают визуализацию, 
не меняя поведения отображаемой величины.

Например, во многих задачах механики конструк-
ций важно с высокой точностью изучить уровни 
механических напряжений: здесь измельчение 
может исказить данные и скрыть от вас важную 
информацию, например об области, где напряжение 
или деформация механического компонента превы-
шает его предел прочности или резко меняется.

Измельчение может также может оказаться 
не самым подходящим выбором, если график 
отображает комбинацию разных скалярных полей.  
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Эти поля могут быть разного происхождения 
и представляться по-разному, и тогда увеличение 
частоты дискретизации вызовет искусственные 
биения. Если вместо интересующих вас разрывов 
(например, в фазовых переходах материалов) вы 
видите плавный переход — значит, визуализация 
скрывает от вашего взгляда важные детали. В таких 
случаях задайте уровень измельчения None (Нет).

С�ЛА¡ИвАНИЕ

Варианты в выпадающем списке Smoothing 
(Сглаживание) накладывают условие непрерыв-
ности на разрывные данные. Как и измельчение, 
это полезно, когда вы уверены, что ваше решение 
должно быть гладким, но выбранная дискретиза-
ция, сетка или модель вносит разрывы в результаты 
моделирования.

Вариант по умолчанию сглаживает величины везде, 
кроме границ областей, где часты резкие переходы 
от одного материала к другому или от одной физики 
к другой. 

вОССТАНОвЛЕНИЕ

Восстановление — это 
алгоритм на полиномиальных 
функциях, который 
воспроизводит значение 
поля с известными 
значениями производных 
(например, потоков или 
напряжений) и имеет 
лучшую теоретическую 
сходимость, чем сглаживание. 
Дополнительная информация 
о настройках восстановления 
приведена в разделе 
Результаты и Анализ 
руководства COMSOL 
Multiphysics Reference Manual 
из документации COMSOL.
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Во время постобработки модели с тонкими 
стенками, смоделированными с помощью поверх-
ностей, или со слоями с присвоенной математи-
ческой толщиной (без соответствия в геометрии) 
вы заметите, что иногда будете получать разные 
результаты при построении графиков на разных 
объектах Поэтому этап, который мы называем по-
стобработкой низкоразмерных объектов, требует 
повышенного внимания.

ПОВТОРение 
ТеРминОлОГии
Давайте вспомним некоторые термины. В пакете 
COMSOL геометрические объекты делятся на:

• Ребра — кривые и прямые линии в гео-
метрии модели.

• Точки — пересечения двух или более 
ребер, на каждом пересечении создается 
точка. Секущие точки — точки, изна-
чально не заданные в геометрии, создан-
ные для целей постобработки.

• Границы — поверхности, со всех сторон 
окруженные ребрами. Когда эти по-
верхности охватывают целую область, 
внутренние поверхности тоже называют-
ся границами.

• Области — объемы, ограниченные 
границами.

Например, в геометрии куба на иллюстрации ниже 
все внешние стенки — границы:

Однако, внутренняя поверхность, отходящая 
от двух стенок, тоже считается границей, хоть 
и не разделяет разные области.

При выполнении постобработки в узле Results 
(Результаты) применяются такие правила:

• Объемные графики отображают результа-
ты на областях

• Графики поверхности отображают ре-
зультаты на границах

• Линейные графики отображают результа-
ты на ребрах

Для некоторых типов графиков важно, на каком ге-
ометрическом объекте они отображаются. Напри-
мер, стрелочные графики бывают и линейными, 
и поверхностными, и объемными — в зависимости 
от геометрического объекта. Графики линий тока 
можно добавлять и в двумерные, и в трехмерные 
группы графиков, но в трех измерениях они ото-
бражают результат на областях, а в двух измерени-
ях — на границах. Графики для отображения сетки 
в то же время очень общие (подойдут для любой 
группы графиков, кроме полярных), а одномерные 
графики включают в себя несколько типов графи-
ков специально для одного измерения.

Эта терминология особенно важна для понимания 
этого последнего раздела руководства.

ПОСТОБРАБОТКА НИзКОРАзМЕРНЫХ ОБЪЕКТОВ
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СВОЙСТВА ТОнКОГО СлОя
В пакете COMSOL «тонким слоем» называется по-
верхность, у которой математически, а не с помо-
щью сетки задана реальная толщина. Тонкие слои 
считаются границами, а окружающие их части 
модели — областями.

Преимущества такого подхода — особенно в муль-
тифизическом моделировании — в снижении 
времени вычисления, поскольку что тонкий трех-
мерный слой не надо покрывать сеткой.

Постобработка низкоразмерных объектов — мощ-
ный инструмент для анализа результатов модели-
рования на одной или на обеих сторонах тонкого 
слоя и решения задач электродинамики, механики, 
гидродинамики и химии. В этом разделе мы об-
судим несколько методов, которые применяются 
в COMSOL для корректной постобработки таких 
случаев и предотвращения ошибок.

Когда мы моделируем трехмерную стенку с по-
мощью двумерного слоя, COMSOL считает тонкий 
слой границей, прилегающей ко всем областям, 
которые находятся в контакте со стенкой.

Если такая граница касается двух областей, на ней 
можно построить результаты моделирования для 
любой из них, либо же построить новую величину, 
зависящую от двух результатов.

Когда вы строите на тонком слое графики области, 
COMSOL обрабатывает результаты немного по-
разному в зависимости от типа используемого 
графика:

• Когда для отображения результатов 
на границе применяется график обла-
сти, COMSOL, как правило, показывает 
среднее значение результатов из обеих 
областей, используя информацию о по-
граничном слое, близком к стенке, если 
такая информация задана в решателе.

• Когда применяется график области, ко-
торая попадает на границу, COMSOL по-
казывает результаты с одной из областей 
в зависимости от положения графика. При 
этом выбирается та область, в которую 
попадает график.

Второй случай существует потому, что графики 
областей (например, трехмерные графики 
сечения) по определению оказываются на одной 
из сторон геометрии тонкого слоя. Даже точки, 
которые должны были бы оказаться точно 
на границе, будут лежать по одну из сторон, 
так как это невозможно выразить при помощи 
численных расчетов. Поэтому графики областей 
покажут результаты, принадлежащие одной 
из сторон тонкого слоя, а не их комбинацию.

Из-за таких различий результаты могут выглядеть 
по-разному на графиках разного типа.

Если же граница не разделяют две разных 
области, то эта граница может касаться одной 
и той же области на обеих сторонах:

СХЕМА МОДЕЛИ

Область 1

ОБОЗНАЧЕНИЯ

ОБОЗНАЧЕНИЯ

Область 1

Область 2

Область 2 Область 2

Область 2

СХЕМА МОДЕЛИ

МОДЕЛЬ С ТОНКИМ СЛОЕМ В COMSOL

Сторона, касающаяся области 1

Сторона, касающаяся области 2

Стенка

Сторона, касающаяся области 2

Стенка

МОДЕЛЬ COMSOL
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Рассмотрим модель теплообменника, в которой 
внутренние стенки, заданные с помощью тонких 
слоев, используются для моделирования задач 
теплопередачи и гидродинамики. Модель кожухо-
трубного теплообменника можно найти в меню File 
> Application Libraries > Heat Transfer Module > Heat 
Exchangers (Файл > Библиотеки приложений > Мо-
дуль Теплопередача > Теплообменники), если у вас 
установлен модуль Heat Transfer (Теплопередача).

Геометрия теплообменника состоит из ряда тру-
бок, по которым течет вода, и кожуха, в котором 
циркулирует воздух. У воды и воздуха на входе 
разные температуры, но, протекая рядом, две 
текучих среды передают тепло и достигают 
равновесной температуры. Такие теплообменни-
ки часто используются в химических реакторах 
и других промышленных установках.

Физическая модель, заданная в Построителе 
моделей, состоит из интерфейса физики тепло-
передачи, интерфейса физики турбулентного 
потока и мультифизической связи, отвечающей 
за неизотермический поток.

В задаче теплопередачи условие тонкого слоя 
используется, чтобы определить термические 
и геометрические свойства всех стенок, а толщина 
5 мм задается математически. Стенки считаются 
теплопроводящими.

Для стенок, разделяющих две области, решение 
будет рассчитано отдельно в каждой области, от-
дельно в граничных слоях, прилегающих к стенке, 
и на границе между областями и граничными 
слоями. 

Температуры двух областей на иллюстрации ниже 
обозначены как T1 и T2.

Граничные слои, характеризующиеся большим гра-
диентом температуры, описываются математически 
с помощью функций стенки.

Выражение для температуры поверхности стенки — 
ht.Twall. Температура на двух сторонах стенки счи-
тается одинаковой, поскольку в этих задачах стенки 
принимаются столь тонкими и теплопроводящими, 
что градиент температуры в стенках пренебрежи-
мо мал по сравнению с градиентом температуры 
в граничном слое.

Когда в дело включается текучая среда, применяет-
ся граничное условие тонкого слоя под названием 
«внутренняя стенка». С его помощью можно смоде-
лировать тонкую область с большими градиентами 
интересующих нас величин вблизи неподвижной 
стенки, хотя свойства потока в этой тонкой области 
могут резко меняться.

В этой модели условие внутренней стенки при-
меняется к турбулентному потоку, что позволяет 
учесть разрывы скорости, давления и переменных 
турбулентности, встречающиеся на тонком слое. 
Программный пакет будет искать решение для ско-
рости текучей среды в каждой области и восполь-
зуется функциями стенки, чтобы учесть появление 
граничного слоя вблизи внутренних стенок, так 
же как и в задачах теплопередачи.

СПрАвкА

Дополнительная информация 
о переменных температуры 
и вычислениях на границе 
приведена в подразделе 
Boundary Wall Temperature 
(Температура стенки 
на границе) раздела 
Heat Transfer Modeling 
(Моделирование 
теплопередачи) руководства 
пользователя модуля Heat 
Transfer (Теплопередача) 
из документации COMSOL.

Граничный 
слой, 
прилегающий 
к стороне 1

СтенкаТекучая среда

Входной поток воздуха

Входной 
поток воды

Выходной поток воздуха

Кожух

Перегородки

Трубки

Выходной 
поток воды

ГРАНИЧНЫЙ СЛОЙ

Граничный 
слой, 
прилегающий 
к стороне 2
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нАРуШения неПРеРЫВнОСТи
Мы сразу заметим все нарушения непрерывно-
сти, если построим график температуры на всех 
границах геометрической модели теплообменни-
ка — график, соответствующий по умолчанию ре-
шению этой модели. Температура, по-видимому, 
резко изменяется на границах между некоторыми 
стенками, а области вблизи входного и выходно-
го каналов, где проходит горячая вода, заметно 
теплее по сравнению с соседними границами, 
контактирующими с воздухом.

Таких разрывов и следует ожидать от модели, по-
скольку у теплопроводящих стенок нет физической 
толщины, в которой температура могла бы изменять-
ся плавно. По этой причине видимого перехода от од-
ной границы к другой на графике температуры нет.

Чтобы увидеть подобные нарушения 
непрерывности на соседних областях, можно 
построить трехмерный линейных график, 
отображающий температуру вдоль ребер 
геометрической модели:

На пересечении некоторых ребер мы видим 
явные изменения температуры. Если приблизить 
эти области, можно легко заметить, как меняется 
температура от ребра к ребру.

ОПеРАТОРЫ Up (ВеРх)  
и DOwn (низ)
Как мы уже упоминали раньше, COMSOL 
может рассчитать значения величины на одной 
из сторон геометрической границы. При работе 
с тонкими слоями можно явным образом задать 
вывод результатов для одной из двух областей – 
в зависимости от того, рендеринг какой из сторон 
требуется выполнить.

Если вы строите график на границе (например, 
график поверхности), а не график области, мы ре-
комендуем использовать операторы Up (Верх) 
и Down (Низ).

Эти выражения имеют вид up(expression) 
и down(expression): up(T), например, выберет зна-
чения температуры из граничного слоя, прилежа-
щего к верхней стороне стенки.

Если у границы есть верхняя сторона, выражение 
up(expression) может быть вычислено. Если у гра-
ницы нет верхней стороны, например если стенка 
касается только одной области, оператор вернет 
нулевое значение.

Предположим, мы нужно построить график 
скорости потока текучей среды, которая будет 
разной на двух сторонах стенки. 

Выражения up(spf.U) и down(spf.U) построят гра-
фик на верхней и нижней стороне стенки соответ-
ственно. Графики, соответствующие выражениям 
up(spf.U) (на иллюстрации вверху) и down(spf.U) 
(на иллюстрации внизу) приведены ниже:
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Операторы Up (Верх) и Down (Низ) работа-
ют на геометрических объектах размерности 
на единицу ниже, чем размерность самой модели. 
Например, в трехмерной модели up(expression) 
и down(expression) могут быть построены только 
на двумерных объектах, то есть на границах.

Это означает, например, что COMSOL сможет 
построить выражение up(spf.U) на графике по-
верхности, но вернет ошибку, если попробовать 
построить то же выражение на графике области 
(к примеру, на трехмерном графике сечения), по-
тому что размерность области равна размерности 
модели.

ОПеРАТОР SiDe (СТОРОнА)
Еще одно выражение, которое используется так 
же, как операторы Up (Верх) и Down (Низ), — 
это оператор Side (Сторона). Это более гибкий 
и точный оператор, который можно применять 
и к объектам гораздо меньшей размерности, 
чем размерность модели. Например, вы можете 
извлечь значения из двух соседних областей для 
точки, которая лежит на пересечении четырех об-
ластей. Это можно использовать, к примеру, при 
интегрировании поверхностных токов на трех-
мерной границе.

Различные варианты оператора side(m, expression) 
вернут данные из объекта размерности n, при-
легающие к области m, для построения объекта 
размерности n-1. Поэтому для правильного ис-
пользования оператора Side (Сторона) могут пона-
добиться метки областей. Например, если выбран-
ная граница прилегает к области 2, но не к области 
1, выражение side(2,expression) построит данные 
в области 2 вблизи выбранной границы, а выраже-
ние side(1,expression) вернет ошибку. 

Например, график скалярного поля скалярного 
поля для построения выражения side(1,T) отобра-
зит на границе температуру с той стороны грани-
цы, которая прилегает к области 1. Если граница 
не прилегает к области 1, side(1,T) вернет ошибку.

Графики строятся таким же образом, если поверх-
ность прилегает к области обеими сторонами; 
оператор Side (Сторона) в таком случае вернет 
среднее значений с верхней и с нижней стороны.

Мы можем продемонстрировать это на графиках, 
построенных на крайних перегородках кожухо-
трубного теплообменника. Крайние перегородки 
касаются и области 1, и области 2. 

Внутренние перегородки, напротив, обеими сто-
ронами касаются области 2:

Стоит обратить внимание на случай, когда выделение 
в наборе данных включает комбинацию границ, 
прилегающих к разным областям. Если мы попробуем 
построить график скорости текучей среды на всех 
перегородках с помощью выражения side(2, spf.U) 
на выделении, включающем все шесть перегородок, 
мы увидим все перегородки, как и следовало ожидать.

Ниже показан график скорости в граничном слое, 
прилегающем к воздушной области:

Однако, если мы попробуем построить выражение 
side(1, spf.U), то мы увидим лишь перегородки, каса-
ющиеся области 1. Ниже показан график скорости 
в граничном слое, прилегающем к водной области, 
построенный с помощью выражения side(1, spf.U):

ИНДЕкСЫ ОбµЕкТА

COMSOL может указать 
на графиках индексы 
объектов, например, 
областей. На иллюстрации 
ниже на трехмерном графике 
построено выражение dom, 
и две области покрашены 
в синий и красный цвета.

Область 1

Область 2

Крайние 
перегородки

Крайние перегородки

Внутренние 
перегородки

ОБОЗНАЧЕНИЯ

ОБОЗНАЧЕНИЯ
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Поскольку внутренние перегородки прилегают 
только к области 2, они не показаны на графике. 
К обеим областям прилегают только две крайние 
перегородки, так что только для них есть данные, 
относящиеся к области 1.

Вы заметите походий эффект, если будете строить 
выражения типа side(m,expression) на трехмерных 
линейных графиках на нескольких выделенных 
ребрах геометрии: в зависимости от того, какие 
величины вы строите и на каких ребрах, некоторые 
ребра могут пропадать. А при попытке построить 
график на ребрах, не прилегающих к заданной 
области, возможно появление сообщения 
об ошибке.

В зависимости от того, что происходит на двух 
сторонах границы, мы можем также обнаружить 
разницу в величинах температуры по две стороны 
границы. Для слоя с повышенной проводимостью, 
например для этих стенок, градиент будет 
практически нулевым, поскольку тепло быстро 
рассеивается сквозь тонкий слой. В слое, сделанном 
из теплоизолирующего материала, напротив, будет 
заметна разница между температурами на двух 
сторонах стенки.

Эти граничные условия задаются в окне Settings 
(Настройки) узла ¢in Layer (Тонкий слой):

ПрИМЕр� �рА¯ИкИ НА ПЕрЕ�ОрОДкА°

На иллюстрации ниже приведен график поверх-
ности на одной из крайних перегородок (граница 
334 в нашей модели), показывающий температу-
ру на стороне, прилегающей к области 1 (слева); 
среднее двух температур, то есть выражение 
T (в центре); температуру на стороне, прилегаю-
щей к области 2 (справа). Наследование стилей 
позволяет сохранить одну и ту же цветовую схему 
во всех графиках. (Заметим, что температура стен-
ки, ht.Twall здесь не показана.)

Но здесь нужно обратить внимание на один 
аспект. График температуры в области 1 выгля-
дит почти однородным — это не ошибка, просто 
оттенки цветов, соответствующие этим темпе-
ратурам, очень похожи друг на друга, а значения 
температуры на других графиках варьируются 
гораздо сильнее. Если мы отключим остальные 
графики и взглянем на первый график отдельно 
(данные для него берутся из области 1), мы уви-
дим ярко выраженный градиент температуры:

СРАВнение ГРАФиКОВ 
ОблАСТеЙ и ГРАниц
Операторы Side (Сторона), Up (Верх) и Down 
(Низ) — мощные инструменты, которые при пра-
вильном использовании могут многое рассказать 
о физическом поведении системы. Мы обсудили 
разницу между этими двумя методами, теперь 
сравним их поэтапно.

Вернемся к графику скалярного поля на одной 
перегородке, в котором выражение T означало 
среднее двух температур по обе стороны 
перегородки.

Допустим, мы добавили диаграмму сечения 
в плоскости yz— обратите внимание, что это 
трехмерный график — расположенную в точке 
xна перегородке, x = 0,5.
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Как мы обсуждали раньше, программный пакет 
выбирает, данные с какой стороны использовать 
для графика. Благодаря наследованию стилей у нас 
будет единая цветовая шкала для двух графиков, 
так что мы можем сравнить график поверхности 
и график сечения:

Графики различаются: трехмерная диаграмма 
сечения показывает температуру с одной 
стороны, а двумерный график скалярного поля 
показывает среднее значение.

Мы не можем использовать операторы Up (Верх) 
и Down (Низ) для построения графика сечения, 
потому что это трехмерный график; если же мы 
заменим выражение в графике скалярного поля 
с T на side(2,T), мы увидим два очень похожих 
результата, за исключением сечений труб:

Исходя из этого, графика сечений показывает 
результаты с той стороны перегородки, которая 
граничит с областью 2. Поскольку область вклю-
чает в себя не только перегородку, но и трубы, 
мы можем увидеть температуру в поперечном 
сечении труб на уровне перегородки (темно-
красные области, которые гораздо горячее самой 
перегородки).

Что если мы немного сдвинем график сечения, 
чтобы он показала вторую сторону? Если вы ра-
ботаете с нашей моделью, сдвиньте координату 
xплоскости диаграммы чуть дальше, чем x = 0,5.

Измените график скалярного поля таким обра-
зом, чтобы он показывал результаты для стороны 
side(1,T), и вы снова увидите два похожих графика:

График сечения снова соответствует графику по-
верхности, но теперь мы обратим внимание на дру-
гую сторону стенки.

СПрАвкА

График сечения (справа) была смещена при помощи жесткой деформа-
ции, благодаря чему мы сможем увидеть оба графика сразу. Подробнее 
об использовании деформаций можно узнать в разделе Деформации, 
выражения для высот и масштабирование. Подробнее о создании гра-
фика сечения можно узнать в разделе Типы графиков руководства 
Основы постобработки и визуализации в COMSOL Multiphysics.

https://www.comsol.ru/offers/Postprocessing-and-Visualization-Handbook-Part-1-ru
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РезЮме
Мы обсудили несколько примеров использования 
модели с тонкими слоями и разобрались в отли-
чиях между операторами, которые нужны для по-
стобработки результатов с одной стороны стенки. 
Вкратце повторим изученный материал:

• Операторы Up (Верх) и Down (Низ) могут 
применяться для показа результатов 
с одной стороны геометрического объ-
екта, чья размерность на единицу ниже 
размерности модели и у которого есть 
верхняя и нижняя стороны.

• Оператор Side (Сторона) может приме-
няться к объектам любой размерности 
ниже размерности модели. Это выра-
жение строит на объектах размерности 
график n на основе данных из указанно-
го прилегающего объекта размерности 
n+1.

Напомним, что неожиданные нарушения не-
прерывности могут появиться на графике при 
постобработке низкоразмерных объектов по не-
скольким причинам.

• Среднее значение температур с каждой 
стороны границы может резко меняться 
от одной границы к другой, поэтому 
на соседних границах могут появляться 
разрывы.

• Так как трехмерные графики «выбира-
ют», сторону, данные с которой будут 
использоваться для построения, сосед-
ние области могут также иметь видимые 
разрывы, если они используют данные 
с разных сторон.

• Когда вы просматриваете комбинацию 
графиков областей и график скалярного 
поля между ними могут обнаруживать-
ся заметные различия. По умолчанию 
графики скалярного поля показывают 
среднее значение, поэтому они, скорее 
всего, будут отличаться от графиков 
областей.

ТЕПЛООбМЕННИк

Модель заполненного воздухом 
теплообменника, состоящего из оболочки 
и системы трубок, в которых течет вода. 
Моделирование позволяет определить 
скорость потока, распределение 
температуры и давление внутри емкости.
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На этом руководство по новейшим методом по-
стобработки в COMSOL завершено. Это руковод-
ство ни в коей мере не является исчерпывающим 
и не перечисляет все доступные операции и гра-
фики. Однако мы надеемся, что это руководство 
помогло вам научиться более эффективно ин-
терпретировать результаты своих исследований, 
повышать их точность, а также подготавливать их 
к демонстрации.

Простота проверки, интерпретации, валидации 
и внедрения изменений в конструкции модели 
значительно облегчает процесс разработки. В ко-
нечном счете эти инструменты помогут значи-
тельно упростить принятие конструкторских 
решений, представить вашу работу коллегам, 
соавторам и заказчикам, а также своевременно 
отреагировать на изменения в продукте. Мы на-
деемся, что узнав о гибких и мощных инструмен-
тах постобработки в среде COMSOL Multiphysics, 
вы сможете вывести качество исследований 
и конструкторских разработок на новый уровень, 
обеспечивая при этом соответствие потребно-
стям ваших клиентов.

зАКлЮЧЕНИЕ

кОЛЬЦА �ЕЛЬМ�ОЛЬЦА

Модель показывает наличие 
однородного магнитного 
поля между двумя 
одинаковыми кольцевыми 
витками, по которым течет 
сонаправленный ток.



О°ЛА¡ДЕНИЕ 
ИСТО²НИкОв ПИТАНИº

Моделирование тепловых 
характеристик блока питания 
компьютера в закрытом 
корпусе. Вытяжной 
вентилятор и решетка 
радиатора создают поток 
воздуха в замкнутом 
пространстве, ослабляющий 
нагрев.


